Introduction

ArcMap is a desktop mapping software package/Geographic Information System that can be used to view, manipulate, and analyze spatial data. It is part of the ArcGIS family of applications that includes ArcMap, ArcCatalog, and other applications. ArcMap is the mapping interface, where you can construct maps from multiple data layers. ArcCatalog is similar to Windows explorer, but is used to organize spatial files. ArcToolbox, a component of ArcMap, includes different tools that allow you to convert data to different formats and perform analyses.

Using ArcMap, you can combine attribute (descriptive) data with spatial data to produce a thematic map. Thematic maps are a useful way to visualize statistical or other data. For example, a thematic map that combines U.S. Census demographic statistics with any Census TIGER boundary file, will show the distribution of a variable such as race, age, or household income across a selected set of geographic divisions, such as states, counties, census tracts, block groups, or blocks.

What is TIGER? TIGER stands for “Topologically Integrated Geographic Encoding and Referencing system”. It is a digital database of geographic features, such as roads, railroads, rivers, lakes, political boundaries, census statistical boundaries covering the entire United States. It also provides latitude and longitude coordinates for each feature. The database contains fundamental spatial attribute information about these features such as the name, the type of feature, address ranges for most streets, the geographic relationship to other features, and other related information.

TIGER basemap features are geographic objects. Geographic objects can be represented by one of three geometrical forms: points, lines, and polygons. Polygons represent things large enough to have boundaries, such as countries, lakes, and tracts of land. Lines represent things too narrow to be polygons, such as rivers or roads. Points are used for things too small to be polygons, such as schools, and fire hydrants, or from a large scale perspective, cities. GIS gives you the ability to layer these features on top of each other to see (for example) how many schools are in a county, and what roads you can take through that county to get to a particular school.

To create a thematic map using ArcMap you will need two kinds of data:

(1) **Spatial data:** A digital basemap displaying boundaries, roads, or some other geographic feature(s). In this exercise, you will use TIGER feature data as your basemap. Spatial data is georeferenced in a real world coordinate system and may contain some attribute information associated with its features.
**(2) Attribute data:** Descriptive information about a set of features and the information needed to create the “theme” in a thematic map. It can be a statistical data set collected through surveys, Census data, or any other information that describes the features represented in your spatial data set. Attribute data must be geographically referenced, or related via one or more identifiers to a physical location. An example would be number of crop acres per county or the number of people who walk to work in a particular Census block. On a map, the county name, the county FIPS code, or other unique identifier are used to link the attribute data with the appropriate county outline on the basemap (i.e. the number of acres). Similarly, a map of the number of people who walk to work in a particular Census block relies on the block IDs to link the attribute and spatial data.

**EXERCISE PART 1: DATA COLLECTION**

With any mapping project in a GIS, data collection is always the first step, and all GIS’s are database-driven. Maps created within ArcMap are cartographic visualizations of the data in the underlying tables. In this exercise you will be working with Census 2000 spatial boundary files and demographic attribute data already retrieved for you from the Geography Network (www.geographynetwork.com).

**Spatial Boundary Data**
The spatial data files you will be working with in ArcMap are located in the `\GIS\GIS_I\` directory in the Classroom Files folder (use the desktop shortcut to get there). These TIGER boundary files are called `tgr36109grp00.shp` (2000 block group boundaries for Tompkins County, NY) and `tgr36109trt00.shp` (2000 census tract boundaries for Tompkins County, NY).

**Attribute Data**
The tabular demographic statistic tables are also located in the `\GIS\GIS_I\` directory. These tabular files are the “attribute data” and are named `tgr36000sf1grp.dbf` (Census 2000 block group information for New York State) and `tgr36000sf1trt.dbf` (Census 2000 census tract information for New York State).

Check to see if there is a folder named “WorkSpace” at the top level of the C:\ drive on your computer. If no such directory exists, create one. It’s important that there be no spaces or special characters anywhere in the path directories of your data files, so be sure to create this directory at the top level of the C:\ drive. Copy ALL of the files in the `GIS_I` folder to `C:\WorkSpace` on your computer.

**Explanation of file names:** Both sets of data files include the New York State FIPS code 36. Federal Information Processing Standards codes (FIPS codes) are a standardized set of numeric or alphabetic codes issued by the National Institute of Standards and Technology (NIST) to ensure uniform identification of geographic entities through all federal government agencies. The spatial filenames include the Tompkins Co. FIPS code 109. The Attribute data files are for all of New York State so they are coded 36000 instead of 36109. The `trt` and `grp` refer to Tract and Block Group respectively. Later on in the exercise you will join these tables together and only look at Tompkins County demographic data.
**EXERCISE PART 2: WORKING WITH TIGER DATA IN ARCMAP**

**Section 1: Bringing the Spatial Data into ArcMap**

1. To open ArcMap: Go to **START** > **Programs** > **ArcGIS** > **ArcMap**. Click **OK** when asked if you’d like to begin with a new empty map.

2. When the program opens you see tools at the top, a table of contents on the left, the map frame to the right and a floating tool bar that you can move anywhere you like.

3. Drag the Toolbar to the top of the frame to dock it in a place that is out of the way of your workspace.

4. Open the **View** menu at the top and make sure the Status Bar is checked, then mouse over **Toolbars** from the **View** menu. You should have the following toolbars checked:
   - Main Menu
   - Standard
   - Tools
   - Draw
   - Layout

5. Dock the toolbars anywhere you like.
6. To add your data to the map view, click the **Add Data** button. This will open a navigation window. Navigate to your C:\WorkSpace folder and select the four files available: tgr36109grp00.shp, tgr36109trt00.shp, tgr36000sf1grp.dbf, and tgr36000sf1trt.dbf. You can hold down the shift key and select them all at once. Click **Add**.

7. Now that your shapefiles and database files are in ArcMap, give the shapefiles in the display more meaningful names.

8. To rename the block groups file, right click on the file named tgr36109grp00 then choose **Properties**. When the **Layer Properties** dialog box comes up, click on the **General** tab at the top. Where it says **Layer Name**, delete the current name and make it “Block Groups”. Click **OK**.

9. Do the same for tgr36109trt00 and call it “Census Tracts”.

10. Unfortunately we cannot change the names of the database files (tgr36000sf1grp.dbf, and tgr36000sf1trt.dbf).

11. The files (now called layers) are added to your “table of contents” at the left. Notice the tabs at the bottom of the table of contents: **Display**, **Source**, and **Selection**. When the **Display** tab is active, you will only see files that can be drawn in the map frame (.shp files). Only when the **Display** tab is active can you change the draw order of the layers.

12. With the **Display** tab active, highlight and drag one layer above the other. Notice how you can only view the one that is drawing on top. Ex: if you have the Census Tract shapefile on top of the Census Block Group shapefile, you will not see any Block Group boundaries.
13. Move the Census Tract shapefile to the top of the table of contents if it is not at the top. Click the color filled box below the file name once. This will open the **Symbol Selector** window.

14. In the **Options** section where it says **Fill Color** click the small down arrow and choose **No Color**, and change **Outline Width** to 2.0. Click **OK**. Now you should see the Census Tract boundaries as thick lines and the Block Group boundaries underneath because you made the Tracts transparent.

15. Experiment with colors, fills and outlines as much as you like, but for the rest of the exercise, both must be filled with a color, and NOT be transparent.

**Section 2: Layer Properties**

1. Right-clicking on any **shapefile** will provide you with many options:

   - **Copy** - copy a layer and paste into the existing data frame, or a new data frame.
   - **Remove** - delete the layer from the project.
   - **Open Attribute Table** - open the table of attributes associated with that shapefile.
   - **Joins and Relates** - join tables based on a common field, or create a temporary “relate” between tables. **Note**: You will perform a join later in the exercise.
   - **Zoom to Layer** - make that layer the focus in the map frame.
   - **Use Symbol Levels** – control the order in which symbols are drawn.
- **Visible scale range** – control the maximum and minimum visible scale range, which creates a scale dependent environment. When you are zoomed in at certain scales, some layers may or may not be visible in the map frame.

- **Selection** - select certain elements of the layer for the purpose of seeing only those specific table records, or create a new shapefile from those selected features.

- **Label Features** - place labels on each feature. *Note:* To set label properties, first open the Layer Properties window (right-click on the layer name and select **Properties**) and select the **Labels** tab. Select the field that contains the label information you want.

- **Convert Labels to Annotation** – as an alternative to using **Label features**, create an annotation file to display labels on your map. This option gives you greater control over the display of labels.

- **Convert Features to Graphics** - change items that are part of the map into plain graphics. Recommended for use with point layers in which a user desires to move the points around on the map individually.

- **Data** - export the data in the current layer to a new file name or in a new location. Ex: you have made a selection and want to create a new shapefile of just those selected features. This also allow you to set a new data source for certain files when moving projects to and from different computers where drive letters or directories change.

- **Save as Layer file** - save the current file, with all of its symbology. Ex: if you have the Tompkins county block groups filled in with pink, each block group labeled with an identifier, and the outline width at 2.0, saving this as a layer file will preserve those qualities and save the file to the map document.

- **Make Permanent (under Data)** – convert the results of a raster analysis to a permanent file (available in ArcGIS Spatial Analyst).

- **Properties** - Open the **Layer properties** dialog box that allows you to perform many different operations on the layer. You can change the **Symbology**, create custom **Labels, Query** to select certain records in the table, and more.
2. Feel free to experiment with any of the tools and operations that have been described here.

3. Right clicking on a **database file** will provide different options. Right Click the `tgr36000sf1grp.dbf` file and look at the options you have:

- **Remove** - remove the table from the project.
- **Open** - open the table in a new window so you can see the attributes.
- **Joins and Relates** - same as above description (join or relate this table to another based on a common field).
- **Data** - same as above description (export data and set data source).
- **Geocode Addresses** - obtain latitude and longitude values for a list of street addresses.
- **Display Route Events** - display events located along routes. Your table must contain route events when you add it to the map document.
- **Display XY data** – Display points on a map. When importing an original table (.dbf) that has latitude and longitude coordinates already in place, you can select **Display XY** and tell it which fields to look at for Lat or Long.
- **Properties** - set alias names for fields, query the table, or perform joins and relates.

**Section 3: Saving Your Work**

Before going any further with the exercise, save your work. Select **Save As** from the **File** menu at the top and choose save your project to the `C:\WorkSpace` directory as an `.mxd` file, giving it a name without spaces or special characters. After saving your project, notice that at the top of the screen says “projectname.mxd – ArcMap – ArcInfo.”
Section 4: Working with Layers and Data

Once again, look at the table of contents and the Display and Source tabs. When you toggle back and forth, notice the change in files listed. Return to Section 1, Step 11, if you need a review on the Display and Source tabs.

1. When you have the Source tab active, you will see ALL the data available to the project, and the path to the directory where the data is located. This includes the two shapefiles and the two database files.

2. Right click on tgr36000sf1grp.dbf and choose Open. Here you will see all the census demographic statistics for New York State by Block Group. Remember that this is only a table and has no spatial component.

3. To see the major difference in files with a spatial component and files without a spatial component, open the attribute tables of each one (a shapefile and a database file). The shapefile table will have a field called “shape” and in this case will be a polygon. The database file will not have this field.

Section 5: Joining Spatial and Attribute Data

In this section we will join the demographic statistics for census tracts and block groups to their accompanying shapefiles. The goal is to thematically map these statistics to see them graphically on the map.

About Joins
Data comes from a variety of sources. Often, the data you want to display on your map is not directly stored with your geographic data. For instance, you might obtain data from other departments in your organization, purchase commercially available data, or download data from the Internet. If this information is stored in a table, such as a dBASE, INFO, or geodatabase table, you can associate it with your geographic features and display the data on your map.

Joins vs. Relates
ArcMap provides two methods to associate data stored in tables with geographic features: joins and relates. When you join two tables, you append the attributes from one onto the other based on a field common to both tables. Relating tables defines a relationship between two tables—also based on a common field—but doesn't append the attributes of one to the other. Instead, you can access the related data when necessary. Join tables when the table on which you're performing the join only has one value for each record in the second table (for example, joining the countries listed in one table with their capitols, listed in a second table). Relate tables when the table on which you're performing the join may have multiple values in the second table associated with each record (for example, joining the countries listed in one table with all of their major cities, listed in a second table).
1. Make sure you have the Source tab active in the Table of Contents.

2. Turn on only the census tract boundary file (tgr36109trt00.shp, the file you renamed “Census Tracts”).

3. Right click the census tract boundary layer name and select Joins and Relates, then select Join.

4. The Join Data dialog box should open. Here you will fill in the drop down menus with the proper information. See steps 5-10 and screenshot below:

5. In the What do you want to join to this layer? box, it should say, “Join attributes from a table”.

6. Choose the field in this layer that the join will be based on: select STFID

7. Choose the table to join to this layer, or load the table from a disk: select tgr36000sf1trt

8. Make sure Show the attribute tables of layers in this list is checked.

9. Choose the field in the table to base the join on: select STFID

10. Leave Join Options set to Keep All Records.
10. Click **OK**. You may see the **Create Index** dialog, which will ask you if you want to create an index for the join field. Click **Yes** and the dialog box will close.

11. Right click on the Census Tract shapefile layer and open the attribute table. Notice the appended fields in the table. The demographic data from the `tgr36000sf1trt` database file has been added to the census tract geography file. Now you can use these fields to thematically map the variables and see them in the map display. Close the attribute table.

12. To create a new shapefile with your joined data, right click on the “census tracts” layer file and highlight **Data**. Choose **Export**

13. Make sure **Use the same coordinate system as this layer’s source data** is checked.

14. Call the new shapefile “tract_demog” [for “census tracts with demographics”] and save it in the C:\WorkSpace directory.

15. Click **OK**. When you are asked if you want to add the data to the map as a layer, click **YES**.

16. After the new shapefile is added to the Table of Contents, turn off (uncheck) the original census tract layer and turn on “tract_demog”.

```
```

```
10```
Section 5: Creating a Thematic Map by Classifying Data

About Classifying
When you perform a classification, you group similar features into classes by assigning the same symbol to each member of the class. Aggregating features into classes allows you to spot patterns in the data more easily. The definition of a class range determines which features fall into that class and which affects the appearance of the map. By altering the class breaks (the boundary between classes), you can create very different looking maps. Classes can be created manually, or you can use a standard classification scheme.

1. Right Click “tract_demog” and select Properties. Click the Symbology tab when the Layer Properties dialog box opens.

2. On the left where it says Show: select Quantities. Make sure Graduated Colors is highlighted.

3. In the Fields section where you have two drop down lists that say Value and Normalization, select POP2000 from the Value list.

4. In the Classification section, leave the method as Natural Breaks, but change the number of Classes to 4.

5. Select a Color Ramp and click OK.
6. Right Click on “tract_demog” and select **Properties**.

7. Click the **Labels** tab. Where it says **Text String**, choose **POP2000** from the **Label Field** list. Under **Text symbol**, change the text size to 10 and make it Bold. Click **OK** and the dialog box will close.

8. Right Click “tract_demog” and select **Label Features**. The map will now show labels indicating the total population for 2000 for each census tract.

9. To remove the labels, right click “tract_demog” again and select **Label Features** to un-check it.

10. At the bottom left of the view frame, you’ll notice three small buttons:

    - The Globe button that is pushed in is the **Data View** button [shows the active data layer].
• The middle button that looks like a page is the **Layout** button [shows the layout view].
• The double arrow button at the right is the **Refresh** button [re-draws the map or layout]

11. Click the **Layout** button to see your data layers in layout view.

12. Click on the map borders and drag it to the extent of the 8.5x11 layout page (or any size that looks good to you).

13. Look at the options available to you from the **Insert** menu at the top of the screen. The **North arrow**, **Scale bar**, and **Legend** choices will bring up a wizard or dialog box to guide you through the process of adding them to the layout view.

14. To change the page orientation to Landscape, choose **Page and Print Setup** from the **File** menu. Change the orientation to **Landscape** in the **Printer Setup** section. Click **OK**.

If time permits, try the same joining and classifying processes for the Tompkins County Block Groups shapefile. The process for joining and classifying for Block Groups is the same. Feel free to experiment with the software and try mapping different geographies or different data. Consult the documentation for ArcMap found within the **Help** system.

For information on GIS, visit Mann Library’s GIS pages: [http://www.mannlib.cornell.edu/research-help/gis](http://www.mannlib.cornell.edu/research-help/gis)

Individuals may also request a GIS consultation by stopping by the Mann Library Reference desk, or contacting the GIS Librarian, Keith Jenkins <kgj2@cornell.edu>.